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ArcGIS Desktop Workshop Supplementary Notes 
Charles Burchill, 2005 

Based on ArcView 3.3 Workshop Notes by C. Burchill and Laurel Jebamani 
 
The following notes were developed for a one day workshop on the use of GIS, 
specifically for the presentation of maps using ArcGIS 8.2, at the Manitoba Centre for 
Health Policy.  Charles Burchill developed and gave the workshop; Laurel Jebamani 
organized the first version of these notes based on the content of the workshop. The 
purpose of the workshop was to provide an introduction to GIS for MCHP staff.   
 
There are a series of map and data files that are required for doing the outlined examples 
and activities.  The required files are listed at the end of this document.  All of the files 
are available from Charles Burchill for use as instructional tools within the University of 
Manitoba. A number of files included are not mentioned in this document – files in the 
FNTS (First Nations) and SCHOOL directories.  These files are used for extra examples 
found in the instructor’s notes and other workshops. 
 
These notes are not meant as a replacement for the ArcGIS Desktop manual.  If necessary 
you can borrow Charles Burchill’s personal copy of the ArcGIS Desktop and extensions 
manuals – please ask to borrow the manual and return it when you are finished.  Since 
ArcGIS is licensed from the University of Manitoba a manual was not provided.   
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Introduction  
 
GIS: Geographic Information Systems, Geographic Information Science, or Geographic 
Information Studies.  
 
What is a GIS? 
In the strictest sense, a GIS is a computer system capable of assembling, storing, 
manipulating, and displaying geographically referenced information, i.e. data identified 
according to their locations.  GIS practitioners also regard the total GIS as including 
operating personnel and the data that go into the system.  The first GIS was developed in 
the mid 1960s (1963) as the Canadian Geographic Information System (CGIS) associated 
with the Canada Land Inventory. 
 
MCHP has been doing GIS analysis since the start of the centre and before.  Much of the 
research repository data is based on geographic data already through postal and municipal 
codes.  MCHP has looked at location of residence, location of service, migration and 
changes in residence.  More recently education measures tied to RHA and Winnipeg 
areas, child inequality measures, and neighbourhood socio-economic characteristics by 
community centre areas. Most of this work was done without ever looking at a map, but it 
is all geographically based.  RHA and other health regions are all geographic units.  
Income quintiles and other SES measures are based on the geographic location of 
individuals and household income by neighbourhoods. In other words GIS is nothing 
new; however, presenting information as maps has not been extensively used and geo-
locating and referencing has typically been done by hand. 
 
Maps have been used and developed using SAS in the past at MCHP.  This was often a 
long and painful process since the maps provided by SAS did not contain the base maps 
required for Manitoba. Creating, editing, and importing new maps into PROC GMAP 
was very time consuming. In addition, using and manipulating map data for presentation 
and basic analysis was difficult. More recently SAS has added a GIS component to its 
software package that makes the process of mapping much easier.  While SAS/GIS 
software has many of the components of GIS packages like ArcGIS, MapInfo, and 
GRASS it is still quite limited. 
 
Content 
 
This workshop covers data presentation using maps and getting data into and out of 
ArcGIS. We will also cover adding some your own data from tables.  The primary tool 
used in this workshop will be ArcMap. 
 
GIS for this workshop is limited to presentation of geographic information using maps. 
This workshop will not be covering creating or editing of maps, geocoding addresses, 
spatial statistics, use of raster/bitmap images, network analysis or other advanced 
techniques.   This is intended as a workshop to provide an introduction to the use of 
ArcMap and some GIS concepts it should not be considered a complete introduction to 
GIS. 
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Tools 
 
ArcMap 8.2 from ArcGIS Desktop ESRI (Environmental Systems Research Institute) 
will be used for this workshop.  There are a few factors which make ArcView or ArcGIS 
the most appropriate choice for this workshop: The UofM has a site licence for ArcGIS, it 
is widely used and supported, and it is primarily a vector based application which works 
well for our needs. Until recently we have not used ArcGIS 8.2 very much because it 
requires more powerful computers than were generally available. A free package called 
ArcExplorer available from ESRI that will allow users to display but not edit or 
manipulate maps or tables.  There are a wide variety of other GIS packages for sale and 
for free: MapInfo, EpiMap, Idrisi, GRASS, etc… 
 

Tools Within ArcGIS 
 Map – display and presenting maps (Relates most to ArcView 3.3) 
 Catalog – Manage storage, locations, defaults, creating new files, meta-data 
 Toolbox – transformations, statistics 
 

Products 
 ArcView ArcEditor ArcInfo 
View shapefiles and coverages  9  9 9 
View geodatabases   9  9 9 
Create/Edit shapefiles   9  9 9 
Create/Edit coverages  9 9 
Create/Edit personal geodatabases  91

 9 9 
Create/Edit multi-user geodatabases   9 9 
Create/Edit feature-linked annotation   9 9 
View feature-linked annotation  9   9  9 
Direct support of many raster formats 92

 92
 92

 

Data conversion and management  93
 93

 93
 

Includes ArcInfo Workstation    9 
License type  
 

Single-use and 
floating 

Floating only Floating only 

Operating Systems Windows NT, 
Windows 2000, 
and Windows 

XP4 

Windows NT, 
Windows 2000, 
and Windows 

XP4 

ArcInfo Desktop 
supports 

Windows NT, 
Windows 2000, 

and 
Windows XP4. 

ArcInfo 
Workstation 
adds UNIX 

support. 
 

1 ArcView supports simple features (points, lines, polygons, and static annotation) in a personal geodatabase, not rules 
and relationships. 
2
 ArcView and ArcEditor support more than 25 raster formats. ArcInfo supports more than 30 raster formats. 

3
 ArcToolbox in ArcView and ArcEditor contains 36 basic data conversion tools. ArcToolbox in ArcInfo contains more 

than 170 data management, analysis, and conversion tools. 
4 ArcGIS Desktop supports both Windows XP Home Edition and Windows XP Professional. 
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Creating a Map and Basic Use of ArcMap 
 
The following section deals primarily with displaying maps using ArcMap.  The ArcMap 
application consists of a map display window for viewing spatial data, a table of contents 
listing layers shown in the display, and a variety of tools for working with spatial data.  
Similar to most current windows applications ArcMap can be modified to meet your 
specific needs with regard to available tools, tool bars, and other preferences. 
 
Starting ArcMap 
 
From the Start menu, go to Programs, ArcGIS, ArcMap. 
 

 
 
 
Data View & Frames 
 
In ArcMap, you begin with a map document. This is a collection of all tables, data 
frames, layers, charts, and scripts. When working with a map document it is important to 
remember that it does not contain any of the spatial or tabular data.  The document is a 
collection of pointers to data files and instructions on how to combine or display those 
files as a unit. The first component of a document we will be dealing with is called a 
Frame. A frame is, essentially, your map or one view of the world; ArcMap can have 
multiple frames all placed in one layout or view. It is where you look at and manage 
much of your mapped data.  When you open a new document in ArcMap, your view will 
simply be a blank page. 
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From here, you add layers. Themes are the components of your map, and work in layers. 
There are four basic kinds of themes; polygons, lines (arcs), points, grids (raster).  Map 
files used by ArcView include ArcView Shape files (.shp), ArcInfo coverage files, CAD 
files such as AutoCAD (.dxf), and raster or bitmap images. 
 
If you want to add a map of Manitoba to your view, you would click on the “add data” 
button on the toolbar or select from the File menu.  
 

  
 
Open the shape file D:\gis_course\rha\rha2002.shp. This shows you a polygon layer 
containing the outlines of the Manitoba RHA boundaries. The outer boundary of this 

If you don’t see the CD drive in the 
dialog box then you will need to 
‘connect’ to the location. 
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theme is roughly in the shape of Manitoba. Click on “add data” again, and open 
D:\gis_course\simple_lakes_and_water.shp.  Multiple shape files can be selected when 
adding views by holding down the shift key when selecting files.  A single shape file can 
be added to a view multiple times to show different attributes of the same features. The 
left frame of your view is called the table of contents and it is used to keep track of your 
themes. Each layer is displayed, by default, with a legend below the layer name. Check 
(click on) the boxes to display the layer in your view. You should now have a view that 
looks something like the image below. 
 

 
 
As you add layers, they show up in the view in layers and are listed in the table of 
contents. The first layers form the bottom layers, while the most recent layers form the 
top layers. It is important that the themes with the largest polygons are added first, so that 
they form the bottom layers. This actually applies to all types of themes. To understand 
why, try adding simple_lakes_and_water.shp before rha2002.shp, activate them both, and 
see what your view looks like. You can fix this by “dragging” your rha.shp layer to below 
the lakes and waters layer. 
 
Once you’ve added your polygons, the next layers to add are arcs. (This is in keeping 
with the wisdom of adding largest featured layers first and smallest layers last.) Arcs are 
lines, commonly road systems on our maps. To add roads to your Manitoba map, click on 
“add data” and open D:\gis_course\rha\major_roads.shp.  
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The smallest layers (and thus the last to be added to our view) are called points. These are 
usually locations of hospitals, schools, community centres, or other discrete locations. 
We will add public schools to our map, by clicking on “add data” and opening 
D:\gis_course\rha\public.shp. Your map now has four themes, or layers: first the rha 
boundaries (a polygon), next the lakes (a polygon), next the major roads (lines), and 
finally, the locations of public schools (points). If you have all of your layers turned on at 
once, you should have a view that looks something like the figure below. 
 

 
 

If you want to get a better look at the southern part of the province, where 
there is the largest concentration of public schools. You can zoom to any part 
of your view by clicking on the “zoom in” button: 
 
When you take your cursor over your view, you should have a little 
magnifying glass  instead of an arrow. You can zoom in two ways: 
clicking the mouse while the magnifying glass is in the view will zoom into 
the map (and re-center the map to where the magnifying glass was 
positioned). If you want to zoom in more quickly, click and drag the 
magnifying glass to create a box around the area you want to zoom into. If 
you want to look at Winnipeg only, make a small box around the Winnipeg 
area, and see how your map looks. The “zoom out” button, just to the right of 
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the “zoom in” button, works exactly the same way, except zooming out instead of in.  
 
If you want to re-center your map but leave the scale the same, use the “pan” button .  
The cursor is now a hand, with which you can grab your map and drag it around until it is 
positioned where you want it. 
 
The button immediately to the left of the “zoom in” button is the “select feature” button 

. This button looks like it has a small arrow and half filled box. You can use this 
button to select different parts of your map. The selected portions will be highlighted 
with a blue outline. 
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You can select or work with multiple layers at one time. Notice 
that, in the above view, the layer for rha.shp to the left of the 
map is highlighted. To limit the layers that are selectable use the 
Selection menu items ‘Set Selectable Layers’. To select more 
than one feature at once, hold down the shift key and click on 
each feature that you want or drag a box around the features you 

want to select. The “select feature” button 
works similarly to the zoom buttons, in 
that you can either click on the map 
(whichever portion of the feature you 
click on will be selected), or click and 
drag a box around what you want selected 
(any portion that falls partly within the 
box will be selected).  You can clear the 
selected portions of a theme by selecting 
‘Clear Selected Features…’ from the       

‘Selection’ menu. 
 

In the tool bar there are a number of other zooming buttons.  Zoom in, Zoom 
out, and “Zoom to full extent”.  The last item looks like a small globe and 
will take you to a view of your entire map.  
 
If you want to zoom to the active layer then right click on the layer of interest 
in the table of contents and select ‘Zoom to Layer’.  This will take you to a 
view of just that theme. If you highlight Simple_lakes_and_waters.shp and 
click on “Zoom to Layer”, you get a close-up of the main lakes of Manitoba. 

 
 

If you want to zoom to a selected feature 
then you can select ‘Zoom to Selected 
Features’ from the Selection menu or 
from the view menu.  This item will zoom 
in on whatever portion(s) of the map are 
currently selected for the active theme. If 
you select Nor-Man, as in the earlier 
example, and click “Zoom to selected”, 
you would get something like the 
following picture. 
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Notice the scale on the upper right side. It tells you the scale of the current view. You can 
change the zoom of your map by entering the scale by hand. Currently, the scale is 
approximately 1:5.2 million. If you zoom to full extent, the scale is approximately 1:14 
million. Large scale will give you lots of detail in a small portion of your map – you can 
zoom to a specific street in Winnipeg if you want. Small scale will show you a large area 
with little detail (such as all of Canada).  . 
 

Within ArcMap all features in a theme have associated information.  This 
information can be displayed by clicking on the information button ( ), then 
clicking on the feature (e.g. a specific polygon) of interest. 
 
It is possible to measure distances in ArcView, using the “measure” button.  
 
When you click on the button, the cursor changes to a ruler. If you want to 
measure the distance between Winnipeg and Thompson, click on Winnipeg in 
your View. Then move your ruler to Thompson. You’ll notice that a line 
appears between Winnipeg and wherever you move your icon. The distance 
between your two points will be displayed in the bottom left-hand corner of 
your screen. If you want to know the approximate road distance between 
Winnipeg and Thompson, you can change the direction of your “ruler” by 
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clicking at the point you want to change direction, and then continuing with a new line. 
The display tells you the total distance as well as the distance of your current line.  The 
distance is measured in the distance units set in the frame properties window. 
 

 
 
Note that the distance measure is displayed in base measurement unit for the frame by 
default. To change it to kilometers, go to Data Frame Properties under the View menu, 
and change distance units to kilometers. 
 
Frame Properties 
 
The properties will allow you to change a number of other settings for the frame.  You 
can change the name of the frame.  Similar to the themes you can have multiple frames in 
a single project.  These frames can display different areas of the same province, the 
whole country or even the world. You can change the background color or even the 
projection (what ever that is…).  Add Grids (measurement) and Graticules (Lat/Long) to 
indicate measurement locations and distances. 
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Changing the Look of your Map  
 
Your lakes are probably some colour other than blue right now. To change them to blue, 
click on the lakes symbol (or fill) in the table of contents.  A dialog that allows you to 
change the fill and pattern should open. Alternatively double-click the lakes title in the 
table of contents.  This will open the layer properties where many more things can be 
changed including the symbology.  Click on the fill color to select the fill and border.  
Lakes are often represented as a light blue with a darker blue outline. 
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You can also have different values of a theme take on different colours. For example, 
within the RHA.shp theme, you could have each RHA take on a different colour.  Open 
the layer properties by double clicking on the layer name or selecting Layer Properties 
from the context sensitive menu.  In the layer properties under symbology select 
categories in the dialog box with the unique values option.  Click on the “add all values” 
button to enter the RHA values.   
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Another option is to display numeric values as quantiles with a continuous gradient in the 
colour. You could group your RHAs by premature mortality rate by choosing 
“Quantiles”, and then choosing D_pmr as your classification field. Again, you are given a 
choice of colour schemes, each colour representing a PMR category. 
 

 
 
 
Polygons are, obviously, not the only themes that can be edited. Double-click on your 
roads legend, and you can change the size of your lines. Points can also be edited, not 
only by colour, but also by size, shape and symbol.   
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You can use the options for multicoloured themes for points as well. If you wanted to 
group your schools by the lowest grade taught at the school, you would choose Unique 
Value under legend type, and then choose Low_Grade under values field. 
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Notice how long the legend for public schools has become – you can’t even see the 
legends for your other themes any more. To fix this, click on the minus (-) beside the 
layer in the table of contents. You should now only have a label for the schools, and you 
should be able to see the legends for your other themes again.   
 
If you want to export your map and have labels for your features directly in your view, 
you can create them using the label menu item from the context sensitive menu or by 
setting up the labels in the layer property. You can also add the labels individually by 
clicking on the “Label” button under the ‘A’.   
 

 
 

Options for label styles and placement position are found in the layer properties. 
 
The layer properties, as you have seen already, allow you to change the properties of each 
layer. You should give your layer theme an appropriate name since you can use the same 
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shape file a number of times in a single view.  This name will also be used for legend 
titles and attribute tables (which will be mentioned below).  This name does not change 
the original shape (shp) file or name on your computer.  
 
You can give the theme a definition and add comments to it under Definition.  A 
definition (e.g. ( [SLI] = “1” )) will be applied to your whole view.  Selections, 
conversions, and other processing will only be applied to the features defined in this 
definition.  
 
The General tab also allows you to specify the minimum and maximum scale at which 
the themes will show up. This is useful for road networks, postal code points, or in our 
example, public school points, when viewed at too small a scale; they clog up a lot of 
Southern Manitoba. Try changing the maximum scale (out beyond) for public.shp to 1.5 
million then zoom in and out around this scale. 
 

 
 
You can take selected portions of your theme and save them as new shape files. If you 
wanted to create a map of Northern Manitoba, you could select Nor-Man and Burntwood, 
and then under the, choose export data from under the context sensitive menu for the 
RHA layer. You can then save them with a new name, such as north.shp, for future use in 
new maps.   
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If you did not want to change your shape file you could limit your layer using the 
definition property    
    "RHACODE" = '70' OR "RHACODE" = '80' OR "RHACODE" = '90'  
 
To unselect the selected features on your map, select the 
“Clear Selected Features” from the “Selection” menu. It will 
remove the selections from all portions of the map.  
 
 
 
Tables 
 
Every layer in ArcGIS has an associated attribute table.  To 
view these tables select “Open Attribute Table” from the 
context menu for the layer in the table of contents.  Attribute 
tables are the actual dbf (dbase IV) files associated with each 
shape file.  When supporting tables are joined to an attribute 
table it only applies to the associated layer even when you have included the same shape 
file multiple times.   
 

 
 
Select the RHA theme and select “Open Attribute Table”.  You will notice that now, 
when you select parts of your theme, they will be highlighted on the theme table as well.  
If you select parts of the attribute table the corresponding features in the theme will be 
selected. 
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Standalone tables can also be added as Dbase IV (dbf), MS Access, delimited text (txt) 
files.  In general you will only add these tables if they have a field that can be joined to an 
existing theme attribute file.  Adding your own data will be covered later in the 
workshop.  When importing text files you may have to create or edit a ‘schema.ini’ file 
that identifies the contents, layout, and delimiters of the file.  ArcGIS will generate a 
schema file in every directory with a file it might be able to read.  This file will be filled 
with a guess at the format.  
 
Example of the schema file in the RHA directory. 

[hosp.txt] 
Format=CSVDelimited 
[nursing_stations.txt] 
Format=CSVDelimited 

 
Attribute tables associated with shape files can be opened outside of ArcGIS. Try 
opening the dbf file associated with the RHA shape file (or theme).  Open Excel then 
open the file D:\GIS_course\rha\rha.dbf.  Remember each shape file has several other 
files associated with it. DBF files are an example of one of these.  You can edit and 
change the dbf file without using ArcGIS.  Be careful not to change the number of 
records or ArcGIS may stop reading the shape file.  If you change the dbf file while 
ArcGIS is running (this is generally a bad idea) you may have to close and re-open the 
project. 
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Charts 
 
ArcGIS has a limited set of charts (bar, histograms, pie, etc…) that can be created from 
tables for presentation purposes.  If you are interested in creating more complex charts 
the data should be exported into a package that does charting and graphing.  To generate 
a chart open the appropriate attribute table (e.g. the rha attribute table) then select “Create 
Graph”.  The graph can be viewed on the screen or added to the layout view (below). 
 

 
 
 
Layout View & Multiple Frames 
 
 To this point most of the work that we have done with the 
GIS is in what is called Data View.  ArcGIS will allow you 
to generate specific layouts that include multiple frames 
(views) of the data, charts, tables, etc… 
 
Layout view is selected from the view menu. A layout lets 
you assemble all the components you want to appear in a 
map including multiple frames (or data views), scale bars, 
charts and other text.   
 
In Layout view there are other options that are specific to 
the layout view.  These are available through the layout tool 
bar.  Many of these buttons have similar functions to those 
in the view window except they apply to the layout and do 
not change what is actually in the view.  For example the zoom in/out and pan options 
change the amount of the page that you see but what gets printed in the end is still what is 
inside the page boundaries. 
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 A new set of items are available from the insert menu that will 
allow you to add frames that contain existing data frames, tables, 
charts and pictures.  Select the type of frame you want to add and 
drag out a square in the layout window. 
 
There are a number of frame properties available in the properties 
for each frame that can be explored on at your leisure.  After a data 
frame has been added you can add scale bars and legends that 
correspond to the view – if you have multiple views you can chose 
which view the scale and legends are associated with.  Legends will 
only display what is still shown as a legend (that is not hidden) in 
the table of contents in the view.  When working with multiple 
frames make sure that the one you are working with is the active 
frame in the table of contents. 
 

Like any frame or object in other vector based programs frames can be 
moved and layered.  Occasionally when a frame is moved the layout 
display will not refresh correctly.  Click on the refresh view button at the 
bottom of the screen. 
 
The page size of the layout and properties can be configured by selecting Page setup… 
File menu. 
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When printing or saving files you should include the following information: date, data 
source, projection, scale.  In a prime example of do what I say not what I do I have not 
included this information on any of the figures in this document. 
 
Saving Map Documents  
 
A map file (or .mxd) file is saved by selecting ‘Save’ or ‘Save As…’ from the File menu. 
A map file contains only pointers to the actual tables and shape files on your computer.  
All of the views, layers, colours, joins, charts, layouts arrangement, etc… are defined 
within the map file.  This means when you re-open a project file all of the joins, and 
legends must be re-generated at that time. Saving a map file does not modify existing 
data. By default the map file contains absolute path names to each of the tables and shape 
files.  This means if you move any of your shape files, tables, or change the name of any 
directories you will need to find them again when you try to open the project.  When you 
open a map file, objects that are not found have an exclamation point ( ) beside 
them.  You can re-assign the source location through the layer properties under the 
Source tab.  If you want to use relative path names there is an option in the map 
properties found under the file menu. 



 

22 

  
 
Save the current file as RHA.mxd (we will be going back to it later). 
 
Activity 1. Basic Mapping of WRHA 

 
Create and save a new map called WRHA that shows the 12 CA regions (12regions2) of 
Winnipeg with Rivers (wpg_rivers, wpg_red_river) and roads (wpg_roads) added. The 
appropriate files are located in D:\GIS_course\wrha for shape files. Change the color of 
the rivers to blue.  Change the colors of the major roads based on the Carto field (1- 
Residential streets, 2 – Access roads, 3 – Major through ways, 4 – Highway, 5 - 
path/lane). 
 
You might want to change the maximum scale so the roads only show up on larger scale 
maps (e.g. 1:50000) 
 
Try mapping premature mortality (PMR) values for each CA.  The PMR values are 
already coded into the shape file. 
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Projections  
 
Open the RHA map file that was saved before the last activity. In our View, Manitoba 
looks expanded at the top. This is because decimal degrees are used as if they are in 
Cartesian space (simple X/Y co-ordinates). However, the actual distances between lines 
of longitude get smaller as the latitude increases. When the map is flattened, the top 
(often near the North Pole) expands.  This is a typical problem with trying to represent a 
globe on a flat surface.  

  
 Earth as a Sphere Cylindrical Projection or Plate Carrée 
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Projections are used to fix this problem. Most of the data at MCHP is stored in decimal 
degrees and needs to be projected.  Some data that you will obtain will be projected 
already – e.g. the conversion has been made already and the underlying data saved in 
projected units (e.g. meters).  Generally decimal degrees provide a wider range of options 
but there are problems when trying to measure some scales, distances, bearings, areas, or 
trying to change projections, share your data with other people or software applications.  
Most simple mapping applications such as EpiMap do not have the ability to re-project 
data and will only display geographic files as they are provided. 
 
When projecting a map there are a wide range of things to consider.   I will not go into all 
of the subtleties during this course suffice to say that if you want Manitoba to look 
normal it must be projected. If you are interested in further information see the following 
WWW site: http://www3.deasy.psu.edu/projection/index.html 

 
To set the projection for your map, go to the frame properties and look under the 
Coordinate System tab. Under the coordinate system select  
Predefined>Projected Coordinate Systems>UTM>Nad 1927>NAD 1927 UTM Zone 
14N. 

 

  
 
The usual projection used for Manitoba is UTM Zone 14 (NAD 83 or 27), although there 
are others.  Manitoba does cross three zones (14, 15, 16) so the east, and especially the 
north east of the province will have more distortion, but zone 14 gives a reasonable 
approximation across most of the province and is suitable for our needs.  If you plan on 
doing large distance/bearing calculations in the east/north east of the province you may 
want to consider another projection.  Which projection you use will depend on your data 
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needs and data source.  Make sure you know the datum that was used to create the data. 
This is a question to ask if someone is providing any map data. ArcGIS can use data 
projected in multiple formats, ArcGIS will allow you to use different projections at the 
same time and as long as they are based on the same datum they should line up correctly. 
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Here is what the ArcView Help file has to say about UTM (Universal Transverse 
Mercator):  

UTM - For the Universal Transverse Mercator System, 
the globe is divided into sixty zones, each spanning six 
degrees of longitude. Zones are numbered from west to 
east starting at 180˚ longitude (the mid Pacific Ocean). 
Each zone has its own central meridian. This projection 
is a specialized application of the Transverse 
projection. The limits of each zone are 84° N, 80° S. 
Method of projection - Each UTM zone has its own 
central meridian from which it spans 3 degrees west 
and 3 degrees east of that central meridian. The 
cylindrical methodology is the same as that for the 
Transverse projection. Note that the position of the 
cylinder rotates systematically around the globe. X- and 
y-coordinates are recorded in meters. The origin for 
each zone is the Equator and its central meridian. To 
eliminate negative coordinates, the projection alters the 
coordinate values at the origin. The value given to the 
central meridian is the false easting, and the value 
assigned to the Equator is the false northing. For 
locations in the Northern Hemisphere, the origin is 
assigned a false easting of 500,000, and a false northing 
of 0. For locations in the Southern Hemisphere, the 
origin is assigned a false easting of 500,000 and a false 
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northing of 10,000,000. 
Lines of secancy  - Two lines parallel to and approximately 180 km to each side of the central 
meridian of the UTM zone. 
Linear graticules  - The central meridian and the Equator. 
Properties 
Shape    Conformal. Accurate representation of small shapes. Minimal distortion of larger 
shapes within the zone. 
Area    Minimal distortion within each UTM zone. 
Direction    Local angles are true. 
Distance    Scale is constant along the central meridian, but at a scale factor of 0.9996 to reduce 
lateral distortion within each zone. With this scale factor, lines lying 180 km east and west of 
and parallel to the central meridian have a scale factor of 1.0. 
Limitations - Designed for a scale error not exceeding 0.1 percent within each zone. This 
projection spans the globe from 84° N to 80° S. Error and distortion increase for regions that 
span more than one UTM zone. 

 
After you’ve projected your map, remember to change the map units to meters under the 
general tab (this should be set since meters is the unit for UTMs) and the Distance 
measure to kilometres or what ever measurement you prefer for distances. Your map 
should now look more like the familiar shape of Manitoba. 
 

 
 
The issue of projections and projected data usually arises when you get data and you 
don’t know the units or projection that it was saved in.  For example, most of our data 
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uses decimal degrees projected into UTM but many groups use data stored as meters 
already projected in UTM.  
 
Convert one of the projected themes in the current project to a new shape file.  Only the 
selected features in the theme will be saved into the new shape file. Note that ArcGIS 
will ask if you want to save in original format (decimal degrees) or projected units.  
Typically you will want to save in decimal degrees.  There are times when you want to 
calculate distance or areas in a specific way, or export the geographic file to another 
application (e.g. MS Map or EpiMap) in these cases you will need to save the shape file 
in projected units. 
 

 
 
When adding imported data to your view, you may run into a problem in which not all 
parts of your map line up. This could be because some of your data is already projected, 
while some of it is still in decimal degrees or the two data sources were generated using 
different datums.  While ArcGIS will allow you to combine in one data view multiple 
projections, sometimes the projection is not known and there will be problems.  If you 
know the projection information it can be added through the use of ArcToolbox. 
If there is a mismatch you typically can only ‘see’ one theme or another. The other 
problem with different datums is more difficult to see (and correct). The difference 
between the North American Datum (NAD 83) and NAD 27 for Manitoba is small and 
generally will not be noticed when working the provincial level.  This is not true when 
working at a small area (e.g. Winnipeg) level. If you want to convert the data from one 
projection to another you will need to use the Projection Utility supplied with ArcGIS 
and available through ArcToolbox.  The Health Regions provided by Health Canada 
(next example) is an example of a file that has been saved in a projected format.  After 
you have imported the ArcInfo file try to add the file to one of your existing views.  Both 
should line up correctly since ArcInfo files store the projection information with the data. 
 
Here is what the ArcView help files say about datums: 
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A datum is a set of parameters defining a coordinate system, and a set of control points 
whose geometric relationships are known, either through measurement or calculation. One 
part of defining the coordinate system is the spheroid used to approximate the shape of the 
earth. 
 
A spheroid is defined by a radius and an eccentricity. These two constants are used as 
inputs to the equations which calculate a projected coordinate from a coordinate in decimal 
degrees. When a projection is created, it is associated with a default spheroid so that these 
constants will be available. This default spheroid varies from projection to projection, but is 
usually the SPHERE for small-scale projections and CLARKE 1866 for large-scale 
projections. 
 
Certain predefined projections (for example, those stored in default.prj in ArcView's etc 
directory which are displayed as "standard" projections in Projection Properties), are 
associated with specific spheroids based on their use. For instance, the "State Plane - 1927" 
projections are associated with the CLARKE 1866 spheroid (with the exception of 
Michigan), the "State Plane - 1983" projections are associated with the GRS 80 spheroid, 
the "New Zealand National Grid" projection is associated with the INTERNATIONAL 
1909 (also known as the INTERNATIONAL 1924) spheroid, the "Great Britain National 
Grid" projection is associated with the AIRY spheroid, and the National Grids of Malaysia, 
Singapore, and Brunei are associated with the EVEREST spheroid. 
 
When a projection associated with a certain spheroid is used, ArcView assumes that the 
decimal degrees data being projected was collected in a datum based on that spheroid. So 
while ArcView has no knowledge of datums per se, it does know about spheroids, which 
are part of the definition of a datum. Therefore you do need to know what datum your data 
is in, and set the spheroid of the projection accordingly. This can be done either through the 
Projection Properties dialog or by using Avenue. 

 
Using ArcCatalog 
 
ArcCatalog is used for managing geographic data.  You can copy, move and delete data.  
There are options to preview existing files and attributes.  Built into ArcCatalog is the 
ability to create and update basic metadata for geographic files.  This is also the place 
where you create new data files.  The ArcCatalog application includes a catalog tree 
display, similar to windows explorer, preview window and several tool bars. In the 
catalog tree each data type (geodatabase, coverages, shape files, CAD files, rasters, and 
TINs) has its own unique icon. 
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Preview and Metadata 
 
The catalog tree shows the available data sources both locally, and remotely.  When 
looking at folders on the local system you must attach or connect to the folder to make it 
available as a local data source – in this way the ‘Add Data’ option in ArcGIS is different 
than the usual Windows open dialog box. 
 

 
 
The Contents window will allow users to select file properties, export, creating new files, 
new directories, and geodatabases.  If both ArcMap and ArcCatalog are open data 
sources can be dropped from ArcCatalog into ArcMap. 
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There is also a preview option that will allow you to see the geography and attribute 
tables.   
 
Metadata for each file can be easily created and updated for every geographic data source 
from within ArcCatalog.  A standardized template for editing and updating metadata is 
provided and when files are moved within ArcCatalog the Metadata is transferred with 
the data. Meta data is saved as XML files in the same directory as the data source or 
within the associated GeoDatabase.  Meta data files can also be exported for use 
elsewhere. 
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GeoDatabases 
 
A geodatabase is a relational database that contains spatial and non-spatial objects. The 
geodatabase supports the storage and management of geographic information in standard 
database management system tables (ESRI Press).  A complete coverage of 
GeoDatabases is beyond this workshop but there has been another workshop developed at 
MCHP for working with GeoDatabases. 
 
There are two broad types of GeoDatabase available to ArcGIS.  At MCHP only the 
personal GeoDatabases are available at this time. 
 
� Personal 

� MS Access format (Microsoft Jet Engine) 
� Multiple users but only one editor at a time 
� Suitable for small workgroups 
� Best performance with fewer than 250 000 objects 
� No Raster data  

� Multi-User (ArcSDE application server) 
� RDBM system such as Oracle or MS SQL server 
� Raster Images 
� Geocoding services 

 
 
Internet Servers 
 
ArcGIS can query and use geographic data available on the internet.  Many of these 
services cost money but there are a few that are free and have some very useful base 
information.  In Canada the most common is www.geographynetwork.ca. 
 
Once attached to an internet service you can add the geography information off of the net 
(from image services or feature services) or make local copies of some files (only from 
feature services). 
 
Geocoding services 
 
ArcGIS will allow you to convert address information to spatial information using 
indexed geocoding services.  These typically are shape files that contain road networks 
and address information.  Setting up and using Geocoding services is an important 
facility but it is beyond what we have time to do during this workshop.  If you have street 
address data and need to convert it to spatial information see the online help or talk to 
Charles about setting up a Geocoding service. 
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Using ArcToolbox 
 
ArcToolbox is a set of utilities that is available for users to do a variety of tasks from 
conversion of file types to spatial analyses.  In this workshop we will only look at 
importing ArcInfo export files and setting/changing projection information.  ArcToolbox 
can be opened by clicking on the toolbox ( ) or by selecting it from the 
Start>Programs menu. 
 

 
 
Importing ArcInfo export (E00) files. 
 
ArcInfo export files, with the extension .E00, are used by most groups to transfer ArcInfo 
data from one location to another.  These file contain ArcInfo coverages. A coverage file 
is a special group of files used by ArcInfo.  An ArcInfo coverage can contain more than 
one class of features.  A polygon feature may also contain line features (arc) which store 
information about the boundaries between each polygon. To the user looking at the 
coverage file from Windows coverages appear to be made up of two directories - the 
coverage directory (e.g. hr46) and an information directory (info).  The group of files 
make up an Arc/Info coverage and includes a wide range of information including label 
points, polygons, lines (that make up the polygons), ticks, network information, 
projection, etc...  Because coverage files are made of multiple parts they are not easy to 
transfer between systems so data providers create an Arc/Info export files when they 
want to move a coverage.  Generally you will want to use ArcCatalog to move and edit 
GIS data sources. 
 
Most Arc/Info files that are available on the WWW or through the DLI (Data Liberation 
Initiative) are in Arc/Info export format (E00).  These files have to be imported or 
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converted from the single file export format to the multiple file coverage. When you open 
an imported coverage file, two new directories will automatically be created – the 
coverage directory and the information directory.  
 
The import program used to convert Arc/Info export files back into coverages is run from 
ArcToolbox by selecting Import to Coverage > ArcView Import from Interchange File. 
 

 
 
Because coverage files are made of multiple parts you will need to open just the part of 
interest.  When viewing a coverage file from within ArcMap, Add Data or in ArcCatalog 
it will appear to have multiple parts (polygon, arc, annotation, label, point etc.).  Many 
CAD files will show up in a similar fashion. 
 
 

 
 
 

Adding/Changing Projections 
 
If you know the projection or type of data that is contained in a shape but it does not 
appear correctly with other shape files it is often useful to define the projection.  This will 
allow ArcGIS to recognize the file and, within some limits, display multiple geographic 
data sources that are stored in different projections. 
 
Inside ArcToolbox select Data Management-> Projections -> Define Projection Wizard 
(shapefiles, geodatabase).  Select the Health Canada RHA shape file saved from the hr46 
coverage polygons.  You might get a warning that a projection has already been defined. 
Click on the ‘Select Co-ordinate System’ button and Import the co-ordinate system used 
by the hr46 coverage file.  If you know all of the projection information you can assign 
this by hand but by taking a quick look at the data fields you will quickly see this can be 
quite complex.  
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Most of the data at the centre is stored in decimal degrees and can have the projection information 
set as North American Datum 1927 (Geographic Co-ordinate Systems -> North American -> North 
American Datum 1927).  Geographic data associated with the 2001 census and most other sources 
can be assigned to North American Datum 1984 or WGS84. 
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Adding Non-Spatial Data 
 
Along with creating tables based on your map’s themes, you can add already-existing 
Dbase IV (dbf), Access (mdb), or comma/tab delimited text (txt) files to your project.  
Using the Add Data button in ArcMap, open the D:\gis_course\rha\rha_stat.dbf file. This 
table of statistics will be added to your Project. 
 
MS Access files are read through the Microsoft Jet Engine.  There are a few limitations 
on using MS Access files.  Select queries created in MS Access must be saved as a table. 
Other types of databases and remote tables can also be accessed through an OLE DB 
provider and ODBC. 
 
I often use Excel to edit ArcView attribute or dbf files, even those associated with shape 
files since the table editor in ArcView is not very friendly.  This is especially true if you 
want to convert field type (character to number), or add and edit fields/records.  If you 
want to use Excel for editing the Dbase (dbf) files make sure you have defined the 
database range in the worksheet before saving.  The database region is defined using the 
Insert>Name>Define menu.  The cells should be appropriately formatted in excel as well 
– avoid using ‘General’ formatting. 
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Microsoft Help for Excel has this to say about saving Dbase files: 

Only data in the named range or current region is saved   When you save an Excel 
worksheet in dBASE (DB2, DB3, or DB4) format and the worksheet contains a range 
named "Database," only data in the named range is saved in the dBASE file. If you add new 
records after naming the range, you must redefine the database range to include the new 
records before you save the sheet in dBASE format. 

If there is no range named "Database" on the sheet, only data in the current region is 
converted. If the first row of data contains text, Excel uses it as the header row to define 
field names. If the first row contains all numbers, Microsoft Excel creates field names such 
as N1, N2, and so on. 

Make sure character strings are shorter than column width   When saving data in 
dBASE format, Excel assigns a data type to each field (column of data) that is based on the 
field data in the first record of the database range or current region. 

If a field in the first record contains text, that field is assigned the character data type, and 
any numbers contained in the field in other rows become character strings. The column 
width of the field determines the string length; character strings longer than the column 
width are truncated in dBASE. To prevent losing data, select the range you want to convert 
in Excel, and apply a monospaced font such as Courier. To size the columns to show all the 
data, point to Columns on the Format menu, and then click AutoFit Selection. Numeric 
data fields cannot contain text; any text in a numeric data field becomes null. 

Use a number format other than General   If decimal numbers have the General number 
format, the decimal places are truncated in dBASE. Before you save the data in dBASE 
format, apply a different number format to all data in that field. On the Format menu, click 
Cells, and then click the Number tab. In the Category box, click Number or Scientific, 
and then specify the number of decimal places you want. 

Change time data to text data   Fields that contain time data cannot be converted. Before 
you save data in dBASE format, you can change time data to text data by using the TEXT 
worksheet function. For example, to change the time 12:34 PM to text data, use the function 
=TEXT("12:34", "hh:mm AM/PM"). 

 
Quote comma (csv) and Tab separated files can be used.  ArcGIS will attempt to read the 
format of the text files and generate a schema.ini file.  The first line in these files must 
contain the names of the fields.  The type of the field, unless all values are in quotes, is 
determined by the content of the field.  This can sometimes cause problems when you 
want a character string field that contains only numbers.  If you cannot join two tables 
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based on a field that appears to contain the same information in two tables check the type 
(character/numeric) of each field.  Character fields are left justified, numeric fields are 
right justified. 
 
When bringing data from SAS the simplest method would be to save the file in DBF 
format using PROC EXPORT or PROC DBF, or as comma separated files using the 
_lotus macro.   Most programmers at MCHP are familiar with the _lotus macro for saving 
comma or tab delimited files.  The advantage to using the _lotus macro is titles and 
program information can be added.  Extra titles and/or comments would have to be 
removed since ArcGIS would not understand what to do with those records. 
 
You can merge your tables using the join feature of ArcMap. The name of the common 
field does not need to be the same but the content must be the same. Typically you will 
want to add imported tables to a layer attribute table.  Once tables have been joined the 
new fields will be available for mapping. 
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Spatial joins can be used to add RHA information to other themes (public schools for 
example). In fact, almost any two attributes tables can be joined with a spatial join. The 
exception is joining a point or line theme into a polygon theme. The spatial join can be 
used to measure distance between points – if you join two attribute tables of points or 
lines, the spatial join table will give you a column with the distance in map units to the 
closest point from the original table. If the underlying table contains a join you will need 
to remove it if you want to join the table to another. The underlying table in any given 
join cannot already be joined to anything.  You can remove all or specific joins to a table 
by selecting remove from the join menu. 
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There is a related option within ArcMap for relating two tables.   Unlike joining tables, 
relating tables simply defines a relationship between two tables.  The fields of the source 
table are not appended into the fields of the destination table.  After a relate is created, 
selecting a record in the destination table will automatically select the record(s) in the 
related or source table. Relates allow a one-to-many relationship to be established 
between two tables.  
 
Just as layers can be used to generate tables in ArcGIS, tables can be used to generate 
layers, as long as the table has X and Y (longitude/latitude) coordinates. In this case we 
will be creating a point layer.  Line and Polygon layers can be created as well from tables 
but the process is more complicated and will not be covered in this course.  Under the 
tools menu choose ‘Add XY Data’ and open D:\gis_course\rha\hosp.txt file. For table, 
choose hosp.txt; for X and Y coordinates, choose X and Y. Click OK, and you should 
now have a new theme called hosp.txt. 
 

Select Spatial 
Joins Here 



 

40 

  
 

 
If you want to generate a theme from a table without X and Y coordinates, you can join it 
to a table with coordinates such as a postal code table. Open the shape file 
D:\gis_course\stat_can\sli_1.shp. Open Tables in the project window, and add 
D:\gis_course\rha\nursing_stations.txt. Now join the two tables (nursing_stations and 
attributes of sli_1) by postal code.  When you join a larger table to a smaller table only 
those records from the active table are retained (see the help information for alternatives). 
Your nursing_stations.txt table now has X and Y coordinates, and you can create a 
nursing station layer through “Add XY Data” using Long and Lat as your X and Y 
coordinates.   
 
Note:  In ArcView Version 8.2, to “Add XY Data”, you must first export the 
nursing_stations.txt table to a database file (dbf).  Use the exported dbf to “Add XY 
Data” using Long and Lat as you X and Y coordinates. 
 
 
Activity 2. Adding Data to WRHA 

 
Open the WRHA map file and add the hospital locations (wpg_hosp) from the 
WRHA directory (D:\GIS_course\wrha) and the PCH shape (pch) from the RHA 
directory.  Select only the Winnipeg PCHs and convert to a Winnipeg PCH shape 
(wpg_pch).  Remember to set the selectable layers to only the PCH layer or you 
might select more than you expect. 
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Open the ca_health data in excel just to see how the file is formatted the close the 
file without saving. 
 
Join the health measures table (ca_health) and social data (ca_social) to the 
community area geographies.  Try mapping various values using different options 
for categories.  Create a map of Winnipeg with a pie chart of GP, Consults, and 
Spec Visits for each CA 
 
Add a second Winnipeg CA theme and map the PMR.   
 
Add a second view that contains the Manitoba RHA areas using an appropriate 
projection. 
 
Modify the map in layout view with a chart of Winnipeg PMR, Manitoba RHA, 
and Winnipeg CAs with PMR and physician pie charts. 
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Selecting Data 
 
At the beginning of the workshop you saw how you could select features in a theme using 
the ‘Select Features’ tool or by selecting records in an attribute table.  Within any GIS 
application you can also select features based on some type of spatial association.  Open 
the RHA.apr project. 
 
Graphics 
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On the toolbar, there is a drop-down menu which can be used to draw graphics on your 
map.  Any features in the selectable layers can be selected using the ‘Select by Graphics’ 
menu item under the Selection menu. 
 

  
 
Choose the circle and click and drag to draw a circle on your map, wherever and 
whatever size you want. (Where you click will determine the centre of the circle.) The 
centre and radius of the circle will be displayed in map distances on the lower left of the 
ArcView window. You can also define the specific X/Y centre and radius for a selected 
graphic circle using “Size and Position…” under the Graphics menu. Once you have 
drawn the circle, you can choose “Select by Graphics” and any features of the selectable 
layers inside or partially inside the circle will be selected by default.  How items are 
selected can be changed using the Selection options. 
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Distance  
 
ArcGIS can be used to find points of a given layer that occur within a specified distance 
from another layer using ‘Select by Location’ under the Selection menu. To find all 
public schools within 20 kilometers of a hospital complete the ‘Select by Location 
options as below. 
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Your map should now highlight all schools within 20 kilometers of a hospital. 
 
A similar effect can be achieved by creating buffers around hospital points. Under the 
tools menu, choose ‘Buffer Wizard’. Choose to buffer the features of the layer hosp.txt 
and click Next. At the next screen, choose to create multiple rings (three, with a distance 
of 10 km between each ring). Then click Next. 
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At the next screen, you can choose whether or not you want the barriers of the buffers to 
dissolve when they overlap. Once you’ve chosen that, save the buffer as a new theme. 
When you click on Finish, a new theme will be created called Buffer of Hosp.txt. Pull the 
theme down so that it’s not covering the points.  
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To select all public schools within 30 kilometers of a hospital, first clear the previous 
selection. Go to Select by Location under the Selection menu. This time, choose to select 
features of the active theme that are completely within the selected features of your 
Buffer layer. When you click on New Set, all public schools that fall within your buffers 
will be highlighted. 
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Obviously, buffers are not necessary for determining distance from points, but they offer 
another option for doing it.  Using another layer (a buffer in this case) for selecting data 
gives you many more options such as those listed below.  This is especially important 
when selecting polygons or lines based on the features of another theme. 
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Activity 3. Selecting Data within WRHA 

 
A. Determine the programs that are within 1km of hospitals. 
 
Add the program data (programs.dbf) table to the WRHA project.  Using the 
postal code on the program file and the 1998 Winnipeg postal code locations 
(wpg_postal98), georeference each of the programs to a specific location using a 
join on postal code.  You should realize that a number of programs do not have an 
associated postal code. 
 
Join the Winnipeg CA areas to the program data so each program is identified 
with an individual community area. Change the symbol colours or shape to 
confirm that each program falls inside the appropriate community area.  Identify 
all of the programs that fall within 1km of hospitals using the select by theme 
option.  Save the selected programs into a new shape file. 
 

 
 
B. Calculate distance from schools with Kindergarten classes to nearest hospital 
 
Add the Winnipeg schools (wpg_public) to the WRHA view.  Query (Select by 
Attributes) the schools attribute table to identify those with kindergarten classes 
(low_grade=’K’ or low_grade=’N’).  Division 1 has some schools that start at 
nursery school (N) all of these schools also have kindergarten classes.  You may 
also limit the data using the Definition property.  Save this file as a projected 
shape file or the distance calculated in the join will be in the shape file units 
(decimal degrees – this is different than the spatial query above for some reason). 
Using the Join option for the new Kindergarten public schools do a spatial join 
with the hospital data.  This will add a distance measurement for each school to 
the nearest hospital. In the attribute table query all kindergarten schools within 
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1km of a hospital.  Convert this to a shape file. Try to reverse the selection so you 
get all the schools more than 1km from a hospital (hint: in the attribute table use 
the switch selection options menu item then select all of the kindergarten schools 
from that set).  
 
You can do a similar selection using select by location options.  An example is 
given below. 
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Note that this 
option is 
different so only 
selected public 
schools are 
included. 
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Exporting Maps 
 
Often we want to use maps in PowerPoint presentations or papers and reports.  If you do 
export the image make sure you save the map file so you can recreate the original image 
at sometime in the future.  There are two basic options for transferring maps from 
ArcMap: 1. They can be copied using ‘Copy Map to Clipboard’ from the edit menu, 2. A 
copy of the map can be exported into a new format.  
 
1. When copying the map it will be copied as an ESRI Map object with all of the detail 

and scalability seen in ArcGIS.  The image can be pasted directly or, optionally, 
pasted as an enhanced meta file in the final document. 

2. Export Map from the Edit Menu. 
a. If you are just sending maps to other people it is usually best to send the maps as 

PDF files.  One of the nice benefits of PDF files beyond being transportable they 
are also searchable for text strings and generally not editable by the end user – 
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what you created is what they will get.  ArcGIS will directly export maps to PDF 
files without having to go through a secondary PDF writer. 

 

 
 

b. If you want to use a map in a PowerPoint presentation or other Windows package 
likely you will want to export the file as an enhanced meta file. Because EMF 
images are vector based they can be scaled in the importing program without loss 
of image resolution. EMF images can usually be ungrouped in a CAD or drawing 
package (even PowerPoint) so different parts can be resized, coloured or modified 
independent of the other parts of the map. 

 
c. JPEG images are a raster format that is often used for presenting information on 

the WWW, used on a variety of platforms/programs, or can be modified in a 
graphics package such as PhotoShop.  JPEG images are preferred for colour 
images that will be used on the WWW or some page layout programs. 
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 Activity 4. Exporting a Map to Power Point 
 
Export the WRHA map layout created earlier with the 12 and 23 regions.  Make sure that 
a legend has been created for the 12 community areas.  Add a scale bar and north arrow 
to the map.  Export both a JPEG and EMF image.  Read both of these into a different 
power point slide.  Try resizing each image to see what happens to the quality of the 
image as it gets larger. Ungroup the EMF to see the different ‘parts’ that the map 
represents. 
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Further Information 
 
What to ask for when getting data  
 
Type of file:  

ArcView Shape (SHP) Make sure you get all the parts  
ArcInfo transport (E00)  
CAD (DXF) 
Personal Geodatabase 
 

Make sure you get the projection, map units, and datum.  Most of our data uses decimal 
degrees with NAD 27 or NAD 83.  UTM projections with map units in meters for zone 
14 are suitable for MB but generally we would rather project from decimal degrees. 
 
If you get an unknown shape, coverage, or E00 file look for the .prj file or prj.adf file.  
These files can be read with a text editor such as Notepad and will give you an idea of the 
necessary projection information. 
 
In some cases files will be posted as MIF (Map Info Transport files).  These can be 
translated into ESRI formatted files if necessary but look for alternatives if possible. We 
do not have converters for other formats. 
 
Presenting MB Data 
 
Generally use UTM zone 14 using NAD 27 or NAD 83/WGS 84 (which ever is 
appropriate). 
 
Albers Equal Area with the following criteria can also be used but this is a custom 
projection and should not be given projected to other people. 
Central Meridian – 98.00 
Standard Parallel 1 – 51 
Standard Parallel 2 – 77 
Latitude of Origin – 63 
 
Spheroid – WGS84 (NAD83) for recent data (e.g. 2001 census) 
 Clarke1866 or GRS80 for older data (e.g. 1996 census) 
 
More on Projections 
 
http://www3.deasy.psu.edu/projection/index.html 
 
Information on Schema files 
 
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/odbc/htm/odbcjetschema_ini_file.asp 
 
Quick and Easy SCHEMA.INI (from: http://www.devx.com/tips/Tip/12566)  
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To create a SCHEMA.INI file for a text file quickly and easily, let the ODBC setup and 
drivers do it for you. Go to the Control Panel and start ODBC. Click on the Add button 
and select the Text driver. Click on the Options button and describe how to arrange the 
text file. If your text file has a header record, click on the Guess button, and the Column 
Names will be filled out for you. On the last screen, choose Cancel to avoid setting up the 
data source. Check the directory where the text file resides, and you'll find a new 
SCHEMA.INI file. 
 
Defaults (Normal.mxt) 
 
The default template (normal.mxt) can be found under the users profile under Windows. 
C:\Documents and Settings\$USER\Application Data\ESRI\ArcMap\Templates 
 
Data Sources 
 
MCHP Network M:\Public\Geography\README.txt 
University of Manitoba DLI – Contact Larry Laliberte or Gary Strike Dafoe Library 
 http://www.umanitoba.ca/libraries/units/datalib/gis/gis.shtml  
Manitoba government through the Manitoba Land Initiative 
 http://web2.gov.mb.ca/mli/mli_data/index.html 
GeoGratis – Canadian WWW site with some very useful information 

http://geogratis.cgdi.gc.ca/frames.html 
GeographyNetwork – ESRI supported site and search engine for geographic data much 

easier to use through ArcView 8. http://www.geographynetwork.ca/ 
GeoCommunity http://www.geocomm.com/sitemap/index.html 

(http://www.gisdatadepot.com/catalog/index.html)  
ArcScripts http://arcscripts.esri.com/  from ESRI http://www.esri.com/ 
Statistics Canada http://www.statcan.ca/english/freepub/82-402-XIE/free.htm 
 
 
Data Used for the Workshop 
 
All of the data used in this workshop is found on the supplied CD.  Shape files are only 
listed as a single file in the following descriptions – remember shape files may include a 
number of associated files.  Several of these files are old (e.g. districts and RHAs) newer 
files should be used from the MCHP M:\public\geography directory. 
 
D:\gis_course 

• Course Notes.doc – Course notes (this document) 
• GIS Workshop.ppt – PowerPoint presentation used in the workshop  
• Lakes and water.shp – A basic polygon shape file showing the larger lakes and 

rivers in Manitoba. 
• Simple lakes and water.shp – A very simple polygon shape file showing only the 

largest lakes in Manitoba 
D:\gis_course\Extensions – A small set of extensions used with ArcGIS 
D:\gis_course\fnts – Maps and data used in the First Nations Deliverable 
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• Community.shp – Locations of First Nations Communities within Manitoba 
• Disease.dbf – Rates of chronic diseases and injuries in Manitoba Tribal councils 
• Mort.dbf – Mortality and life expectancy measures in Manitoba Tribal councils 
• Reserves.shp – Polygon shape file of the Manitoba reserves 
• Tc.shp – Tribal Council areas within Manitoba (note Northern Independent 

combined into one area for this workshop) 
• Tc_names.txt – Tribal council names for individual codes.  Comma separated file 

D:\gis_course\Health_reg 
• HR46.E00 – ArcInfo export file of the Manitoba Health regions as used by Health 

Canada.  This file is projected into X/Y Cartesian co-ordinates (meters).  
Specifically: A Lambert projection in meters based on the clarke1866 (NAD27) 
spheroid.  49 degrees 1st standard parallel, 77 degrees 2nd standard parallel, -
91˚ 52’ central meridian, Origin 63˚ 23’ 26.4300, 6200000 false easting (meters), 
3000000 false northing (meters). 

D:\gis_course\Place_names\ 
• ESRI Place Names – Place names from ESRI (geographynetwork.ca) 
• Geogratis Place Names – Manitoba Place Names from Geogratis. 
• MB Place Names – Place names from the Manitoba Land Initiative. 

D:\gis_course\rha – RHA data for this workshop 
• Districts.shp – RHA sub-districts for 2001. 
• Districts2004.shp – RHA sub-districts for 2004-2005 
• Districts_stat.dfb – Various statistics for RHA districts (2001 format) 
• Hosp.txt – Hospital locations and types with X/Y (long/lat) included.  Comma 

separated file. 
• Major_roads.shp – Major Manitoba roads and highways 
• MB_ea.shp – 1996 enumeration areas within Manitoba 
• Nursing_stations.txt -  Nursing stations within Manitoba with associated postal 

code and type of station 
• Pch.shp – Locations of PCHs within Manitoba 
• Public.shp – Locations of public schools within Manitoba including division, 

type, grade ranges 
• Rha.shp – RHA boundaries 1997-2002 
• Rha2002.shp – 2002-2005 RHA boundaries 
• Rha_stat.dbf – Some basic health statistics for each RHA including SERI, 

Hospital sep/days, life expectancy (1997 format). 
• Rhad_csd.shp – Census sub-divisions with RHA and RHA districts coded 

D:\gis_course\school – Information on 1996/97 Manitoba School divisions 
• Schoold.shp – school division boundaries 
• Scores.dbf – Average scores for various subjects in Manitoba Schools (S4 Math, 

S4 English, Grade 3 Math) 
D:\gis_course\stat_can – Statistics Canada Data 

• Pccf46_NOV01.txt – Comma delimited version of November 2001 PCCF file 
• Sli_1.shp – Single link points from PCCF file 
• RHA-DA 2001.zip.  -  Correspondence file for MB RHA and 2001 DA 

http://www.statcan.ca/english/freepub/82-402-XIE/00503/corr.htm   
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• RHA-EA 1996.zip  - Correspondence file for National health regions and 1996 
EA http://www.statcan.ca/english/freepub/82-402-XIE/00503/corr.htm 

• National_Health_Regions.zip - ArcView shape file for current national Health 
region boundaries. This file is saved in projected units (meters) – NAD83, 
Lambert Conformal Conic  (See prj file for information).  

• Manitoba RHA.zip - the current (2003) RHA boundaries in projected units. 
• Manitoba RHA_D.zip - the current (2003) RHA boundaries in decimal degrees 

(NAD83). 
• PCCF July 2004.zip – Limited PCCF for this workshop in DBF format based on 

July 2004 PCCF file for Manitoba. 
D:\gis_course\wrha – Winnipeg Regional Health Authority information 

• 12regions2.shp – 12 Community Characterization Areas of WRHA 
• 23nrns.shp – 25 Neighbourhood Clusters of WRHA 
• ca_health.dbf – Various health measures for 12 Community Characterization 

areas 
• ca_social.dbf – Various neighbourhood social measures for 12 Community 

Characterization areas 
• Com_Club.txt – Community Centre names and addresses in comma separated 

format 
• Library.dbf – Library names and addresses in dbf format 
• Parks_rec.shp – Parks and recreational areas within Winnipeg CMA 
• Programs.dbf – Social and community programs within Winnipeg with addresses 

and postal codes 
• Seine_river.shp – Seine River shape file 
• Worship_address.txt – Places of worship within Winnipeg with addresses 
• Wpg_bound.shp – Boundary of WRHA 
• Wpg_ea.shp – Winnipeg enumeration areas includes average household income 
• Wpg_hosp – Winnipeg Hospital Locations with hospital names and type 
• Wpg_postal98.shp – 1998 PCCF 
• Wpg_public.shp – Public schools within Winnipeg with name, address, postal 

code, grade ranges and type 
• Wpg_rivers.shp – Arc (line) shape file of Major Winnipeg Rivers.  Should be 

used with wpg_red_river polygon file 
• Wpg_red_river.shp – Polygon shape file for Red River through Winnipeg 
• Wpg_roads.shp – Winnipeg street network file used for geocoding 
• Wpg_streams.shp – Smaller Winnipeg streams and rivers 

 


